Getting Started
A guide for your Apple MacBook Learning Lab
Contents

Introduction 4

Setting Up and Working with Your Apple MacBook Learning Lab 6
Setting Up Your Apple MacBook Learning Lab 6
Daily Setup 9
Sharing the Lab 12
Creating and Managing User Accounts 12
Installing Software 14
Sharing and Storing Files 16
Apple Remote Desktop: Managing Student Computers from One Computer 17
Using Parental Controls to Provide Extra Security 18
Maintaining Your Apple MacBook Learning Lab 19

Using the Tools That Come with Your Apple MacBook Learning Lab 22
Using iChat to Communicate and Collaborate 22
Having Instant Access to Information with Widgets 24
Finding Files in a Flash with Spotlight 25
Crunching Numbers with Calculator and Grapher 26
Browsing the Internet with Safari 27
Staying Up to Date with iCal 28
Producing Digital Media Projects with iLife 29
Creating Digital Stories with iMovie 30
Creating Digital Music and Podcasts with GarageBand 31
Organizing, Editing, and Sharing Digital Photos with iPhoto 32
Building Websites and Blogs with iWeb 33
Organizing and Playing Music and Audio with iTunes 34
Reaching All Learners with Built-in Accessibility Features 35
Communicating via Email with Mail 36
Supporting Writing with Dictionary and TextEdit 37
More Tools to Use with Your Apple MacBook Learning Lab 38
Enhancing Student Learning with K-12 Curriculum Collections 38
Using iPod as a Mobile Learning Tool 39
Creating, Presenting, and Publishing Work with iWork 40

Additional Resources 41
Apple Learning Interchange 41
Apple Websites 41
Apple Professional Development 42
Apple Support 42
Apple MacBook Learning Lab Teacher Sign-Up Sheet 43
Apple MacBook Learning Lab Student Checkout Sheet 44
Apple MacBook Learning Lab Teacher Checkout Sheet 45
Introduction

This guide is designed to help you get started right away using the Apple MacBook Learning Lab in your classroom. It includes suggestions that can help you with setting up, maintaining, and managing your lab, as well as many ideas for great ways to use these powerful tools in your classroom. The information in this guide has been provided by teachers who have extensive experience using mobile labs in their classrooms.

Apple MacBook Learning Labs offer a compact, convenient—and exciting—way to bring the latest technology tools into the classroom. The cart is ready to roll into any classroom, providing students with immediate access to a full computer lab, complete with wireless connection to the Internet. Apple MacBook Learning Labs are the most durable, well-designed, and simple-to-use mobile technology solutions available for schools.

Each lab includes a sturdy and secure mobile cart designed specifically for school use. With this cart, you can store and charge up to 32 computers by using only a single power plug controlled by an automatic timer, ensuring that the computers are fully charged and ready for student use at all times. This convenience means that it will be easier than ever for you to integrate technology into your classroom activities. And this ready access to technology can give your students the tools they need to increase achievement, while at the same time learning critical 21st century skills.

With the purchase of an Apple MacBook Learning Lab, you receive a classroom set of notebook computers with pre-installed software, Apple Remote Desktop software for computer management, and an AirPort Extreme Base Station for wireless networking. With this wireless network, students can use the Internet, print documents (with the addition of a printer), and share files, working wherever it’s most convenient for them.
The computers that come with your lab have been designed with student use in mind. They are durable and reliable, have a long battery life that can last throughout the school day, and are very simple to use, keeping the focus on learning, instead of on the technology. These computers are rich with built-in features and software, details of which are included in this guide.

The lab's cart comes to you already assembled and is very easy for you to customize to meet your needs. It comes with removable dividers that you can configure as you like, as well as tubs for storage of accessories. Your cart has been designed with special features that make it easy to move between classrooms.

With an Apple MacBook Learning Lab, you can rest assured that your students have access to the most innovative technologies and are empowered with highly effective tools to help them achieve success. This all adds up to a terrific way to promote collaborative, project-based learning in the classroom.

Special thanks to the following educators for their contributions to this guide: Robert E. M. Craven, Coordinator, Educational Technology, Orange County, CA Department of Education; Dr. Bruce E. Ahlborn, Technology Coordinator, Northbrook Junior High, Northbrook, IL; Kathleen Ferenz, Technology Specialist, California Technology Assistance Project; and Anthony H. Robinson, Technology Director, Putnam County Schools, Cookeville, TN.
Setting Up and Working with Your Apple MacBook Learning Lab

Before you begin to use the Apple MacBook Learning Lab in your classroom, there are a few basic initial setup steps that need to be done, such as inserting the dividers in the cart, placing the computers in the cart, configuring your wireless network, labeling the cart and each computer, installing software (if you plan to do so), and setting up user accounts on each computer. If you have a technology team at your school, this initial setup might have been done for you. If so, you can jump right to the “Daily Setup” section of this guide to get started using the lab in your classroom. If you’re responsible for getting the lab set up, see the “Setting Up Your Apple MacBook Learning Lab” section to learn what you need to do.

Before setting up your lab, you should first figure out where student work will be stored and how software will be installed. Either your school uses a server where student work can be stored and from which software will be installed, or you will store student work and install software right on the individual computers. If your school has a server, you have the added benefit of permitting students to access their work from any computer in the school via this network. This also means that for software titles that incorporate a management system that tracks student work, you’ll be able to receive reports of all of your students’ progress from one centralized computer.

Your lab works well with or without access to a server. Knowing whether or not you will have access to a server will make it easier to follow the steps in this guide, which provides information for using either environment.

Setting Up Your Apple MacBook Learning Lab

The following information will help you with the initial setup of your lab. You can do these steps on your own or with the help of other staff members or volunteers. The initial setup of the cart provides an excellent opportunity for training a group of student volunteers on installing software and operating the computers as well as the setup and care of the technology.

Arranging the Dividers

The cart is shipped to you already assembled, making setup very simple. The cart is designed to be flexible, so you can configure it exactly to meet your needs. You can set up the dividers in your cart depending on how many computers came with your lab—each computer will have its own slot. If you don’t have the maximum number of computers for your cart (either 20 or 32, depending on the model of the cart), you’ll have extra room in the cart that you can use to keep the cart’s storage tubs or other items.
Charging the Computers
Once you've opened the cart and put in the dividers, put each computer into its slot and plug each computer into the outlet above the slot to charge, making sure the cord slips through the opening above the computer to keep it in place. Note that there are two multiple-outlet electrical panels inside each cart, each providing power to one shelf of computers. There's an on/off switch on the lower left of each electrical panel; keep this switch set to the on position to facilitate use of the timer if you will be using both shelves to store and charge computers.

Before you plug the cart into a power outlet for charging, make sure the power switch on the side of the cart is in the off position. (This switch turns on the charging timer.) Turn the switch back on after you've plugged in the cart. When it's on, the charging timer automatically switches the electrical current from the top electrical panel to the bottom electrical panel. This means you can just plug one cord into an outlet and charge all of the computers overnight. Indicator lights next to the switch show you which shelf is charging. See the documentation that came with the cart for detailed information about using the timer.

Make sure to fully charge the computers before they are used the first time.

Plugging in the Base Station and Other Peripherals
The lab's cart includes a power strip with four power outlets on the top of the cart for plugging in the AirPort Extreme Base Station and any other added accessories, such as a printer or projector. To use this accessory power strip, open the cover at the top of the cart and locate the four-outlet power strip. Plug the power cords for the peripherals into the power strip and then plug the power cord for the power strip located on the side of the cart (the opposite side from the timer) into an electrical outlet.

Setting Up the Wireless Network
Your lab comes equipped with AirPort Extreme, an easy-to-use technology that sets up a wireless local network for the cart’s computers, allowing students to automatically connect to the Internet from anywhere in the classroom, without any cords to trip over.

As you begin setting up your lab, you’ll need to collect some basic information about the network in your school. Confirm that a network addressing scheme called DHCP is available. Also, identify where Ethernet ports with an Internet connection are located in your classroom; you’ll connect the AirPort Extreme Base Station to an Ethernet port. Since it’s easiest to keep the base station on top of the cart, it’s best if you can use a port close to where you can park the cart, such as along the classroom’s back wall.

Before the first time the lab is used in your school, you need to use the AirPort Utility software on one of the computers to quickly set up the network. Plug the base station into a power outlet and use the Ethernet cable to connect the Ethernet port (the one with the two arrows) on the base station to the classroom Ethernet port. Then start up one of the computers and open AirPort Utility, which is located in the Utilities folder in the Applications folder. Follow the onscreen instructions, and your wireless network is ready to use.

For more information about setting up AirPort Extreme, go to the AirPort Support at http://www.apple.com/support/airport.
Labeling the Cart and Computers

An easy-to-use labeling scheme will help you efficiently store, organize, track, and maintain the computers in the lab. It's especially important to have a simple labeling scheme if you want each student to be able to identify and use the same computer during each class session.

Your school may already have a labeling scheme for other carts that you can use for your new cart. It’s a good idea for each cart to have a unique name and for each computer in the cart to be individually labeled. If you’re developing the labeling system, you could use a letter for the cart and a number for each computer, for example, C-1, C-2, and so on. Then you’ll want to clearly mark each computer with its label, which you can do by using the white Apple stickers that come with each computer or by printing names on stickers and then putting the stickers on the lids of the computers. Making the labels big enough to be read from a distance and placing them in the same location on each computer will permit you to view each label when the computers are open on student desks.

On the slots of the cart, place stickers with the same names as the computers so that it’s easy to always put the computers back in the same locations in the cart. Also, make sure to put a label on the cart itself with its identifying letter, number, or other name. Finally, labeling the adapters to correspond with each computer will help you keep track of them if you remove any from the cart to charge a computer during the day.

Keeping Records

Teachers have found that it’s helpful to develop a simple record-keeping system to assist with managing the lab. By creating and maintaining some basic forms, you will be able to readily develop a checkout system for the cart, set up and identify the equipment, make sure students use the same computers, and always know the location of the cart.

• You might want to print a simple checklist to identify the daily setup routines and store it in the pocket inside the cart’s door. This will be especially useful if volunteers or others unfamiliar with the lab are helping with setup. You could also put a photo on the inside of the cart that shows what the cart should look like when everything is in its proper place.

• If each student or student group will be assigned to the same computer each class period, you can prepare a list with these assignments to make it easy to give out the computers in each class. You can also create a checkout sheet for students to use whenever they have the computers.

• A basic inventory list can be created using a spreadsheet or database file so that you have a record in one place of the serial numbers and names of the computers, as well as other relevant details, such as amount of memory, the version of the operating system, any repairs made, and if the computer is covered by AppleCare.

• You may want to create a daily log that stays with the cart to note any issues with computers or other equipment. For example, if something breaks or is not working properly, a log will help you remember which computer is in need of repair or maintenance.
• A calendar can be used for teachers to sign up to use the cart for a specific class period or time of the day. For sample sign-up and checkout forms, see “Additional Resources” later in this guide.

**Setting Up the Computers**

The next step is to turn on and set up each computer for student use. When you first turn on the computers, the setup assistant walks you through setting up the computer and connecting it to the network. Once this is complete, you’ll then want to create user accounts and install any additional software. To learn more, see “Creating and Managing User Accounts” and “Installing Software” later in this guide.

**Daily Setup**

Once you or your technology staff have completed the initial setup steps described earlier, you’re ready to use the lab with your students. Each day that you use the lab, it takes just a few minutes to set it up and have your students start using the computers. You’ll follow a few simple steps to set up the equipment:

1. Plug the power cord for the accessory power strip on the side of the cart into an electrical outlet. (If you want to charge computers that are in the cart at this time, you can also plug in the power cord for the charging unit. Before you do this, make sure the power switch on the side of the cart is off. Turn it back on after you’ve plugged in the cart.)

2. Connect the AirPort Extreme Base Station and the printer (if you have purchased one). (See the next section.)

3. Distribute the computers to the students. (See “Distributing the Computers.”)

4. If you’re using any other peripherals, take them out and connect them, such as a digital video camera, iPod, or digital microscopes.

**Using the AirPort Wireless Network**

To set up the wireless network, place the AirPort Extreme Base Station on the top of the cart and plug it into one of the accessory outlets on the top of the cart, making sure the power cord for the accessory power strip is plugged into an electrical outlet. Flashing green lights on the base station indicate that it is receiving and sending a signal. Use the Ethernet cable to connect the base station to the Ethernet port in the classroom.

If you have a printer, set it up by placing it on top of the cart and making sure the power cord is plugged into one of the accessory outlets on the top of the cart. Connect the printer cable to the USB port on the base station and turn on the printer.

That’s all there is to it. When students turn on their computers, each will automatically connect to the wireless network. With the wireless network, all students can be using the computers and accessing the Internet at the same time, as long as they are within 300 feet of the base station.

For more information about using AirPort Extreme, go to the AirPort support page at http://www.apple.com/support/airport.
Distributing the Computers

Once the base station is connected, you’re ready to distribute the computers to the students. You’ll want to develop a classroom management strategy for doing this in an orderly way and demonstrate to the students how this will be done. For example, you can take computers one or two at a time to students at their desks or call them up to get them two or three at a time. You’ll want to prevent students from rushing to surround the cart and grab the computers. You’ll also want to make sure that the computers are unplugged properly from the cart and then carefully plugged in again at the end of the class. Student assistants can help with the distribution process. If you will have each student use the same computer whenever the cart is used, you can consult an assignment sheet so that each student receives the correct computer.

Allow enough time at the end of the period to put away the computers. Students need time to save files, quit applications, log out, and close the computer lids or shut down. (If it’s the last period the cart will be used for the day, students should shut down the computers before closing them.) At the end of the period, you can use the same method you used to distribute the computers to return them to the cart. For example, you or student assistants can collect the computers one or two at a time, place them in their correct slots in the cart, and plug them in. You can make a final check of the cart to make sure everything has been replaced properly and then close and lock the cart (if necessary). When the next period begins, the process repeats itself.

Printing Documents

Note: It is recommended that you purchase a printer for the cart to allow students to print wirelessly from anywhere in the classroom. This section provides information on using the printer with the cart.

If you have purchased a printer with your cart, once it is set up, all students have to do to print is to choose File > Print from within whatever application they are using. A dialog appears that allows them to select a printer and print their documents. If you purchased a printer with your Apple MacBook Learning Lab, it will connect wirelessly to the computers and appears as a choice in the Print dialog. If the printer is not already displayed in the Print dialog when students first choose Print, they should choose Add Printer from the Printer pop-up menu, select the printer in the dialog that appears, and click Add.

When printing is in progress, an icon for the printer appears in the Dock on the computer. Clicking the icon opens the Jobs window where students can view the items set to print, check the progress of their print request, and manage their printing. For example, if students see duplicate items in the window, they can delete those items they don’t want to print. Suggest to students that they should always check the Jobs window for messages if their document hasn’t printed; the print jobs might be on hold, the printer might be out of paper, or they may have accidentally selected the wrong printer.
You might want to name the lab’s printer so that it won’t be confused with any others on the school network. You can change the name of the printer in the Print & Fax pane of System Preferences. Click the printer’s name in the list of printers, then click Options & Supplies. In the General pane, type a new name in the Name box, then click OK.

The following are additional classroom management tips for efficiently printing documents in the classroom:

• To minimize the number of drafts that are printed, students can proofread each other’s work onscreen before they print.

• Before printing, students should check with you or an assistant who is in charge of the printer. This helps make sure only a few students are printing at the same time. It’s a good idea to have students stop printing at least ten minutes before you collect the computers so that all documents are printed by the end of class. Before the computers are put away, students should use the Jobs window to delete any print jobs that are still in progress before they hand in the computers. This will prevent the printer and computers from being tied up during the next class period. (Students should make sure to delete the item, not stop printing, which stops all print jobs.)

How long printing will take depends on the number of pages in a document, the type of document (images can take longer), and how many students are printing at once.

For more information about printing, choose Help > Mac Help from the Finder.

Storing the Cart

A brief check of the computers inside the cart at the end of each day will ensure that the cart will be ready to use the next day. You should make sure that all computers are accounted for and shut down (no glowing lights near the clasp), that they are stowed in their proper slots, and that they are plugged in and charging (check for a glowing green or orange light on the plug). See if any problems have been reported on the equipment checkout sheet. All peripherals should be stored properly, whether they are kept on the top of the cart, in the storage bins in the cart, or in another secure location. (You can use a purchased lock and cable to secure the base station and a printer to the top of the cart. The cable goes through the one-inch metal opening that is located directly below the accessory power strip.) Double-check that the cart is properly locked and plugged in when you’re done. (Use the cord on the side of the cart with the power switch when you’re storing the cart overnight.)

If you need to move the cart to or from its storage location, it’s best to work with one other person to make it easier to open doors, negotiate ramps, and so on. You can open the cart at your destination to check that all the computers are plugged in; then lock the cart. Keeping all peripherals in the storage bins that are included with the cart will prevent them falling off the cart if you hit an unnoticed bump. When you arrive at your destination, set the wheel brakes so that the cart doesn’t accidentally move and then plug in the cart.
Sharing the Lab

There are a variety of ways to work out sharing a MacBook lab among different classrooms. In some schools, each teacher has the lab in their classroom on a specific day each week, or for specific periods of each day; in other schools, teachers sign up on a first-come, first-served basis. In some schools, teachers sign up using a digital scheduling system that is accessed via a school intranet or on the Internet. Some schools schedule cart use with a printed calendar kept in a binder in a central location. In other schools, the carts are kept in the library media center and are scheduled and tracked using the computerized library checkout system.

Creating and Managing User Accounts

Mac OS X, the current version of the Macintosh operating system (the software that runs the basic computer functions), is installed on all of the computers included with the lab. Mac OS X is a multiuser system designed to create discrete spaces for each user’s work. With Mac OS X, each computer has at least one “administrator” user who can install software, change settings, and set up accounts for additional users. Each user has a separate home folder that includes folders set up for different types of files, such as Movies and Documents. Once a user account is set up for a computer, the person using that account “logs in” as that user and can only see that user’s files.

In some schools, the technology staff will set up the user accounts before you begin to use the lab in your classroom. If you are the one who sets up these accounts, however, how your students will use the computers and whether or not your school has a server will help determine your setup plan.

You will set up one administrator (or “Admin”) account on each computer. Using the same administrator user name and password on each computer will make it easier if you need to log in to that account on all of the computers. It’s preferable to set up at least one non-administrator student user account so that students won’t be able to make unlimited changes to the computer’s settings. When setting up additional users, you can also select customized settings for each user account, such as for accessibility features and security options.

If your school uses a server, students can save their work in individual folders located on the server. You can use a special kind of user account, called a mobile account, and portable home directories as a way for students to have a network account while also saving work on individual computers. Mobile accounts are primarily used for students who are assigned a specific portable computer for their use. With this type of setup, you can manage the computers and student accounts centrally, making it easy to change preferences and other settings for all of the student computers. Students are able to access their work on the computer that has their home folder even if they’re disconnected from the network. The students’ work is automatically synchronized with the files saved on the network, so students can work on different computers in the building and still access their work.
For additional information on mobile accounts and portable home directories, visit the following website:


If there is no server, or if you find it easier for students to have their files on the computer, they will save their work on the individual computers. Even if your school has a server, it’s often a good idea for students to save their work on individual computers instead of the server if they’re working on projects that result in large files, such as digital movies. If students save their work on the computers, they will need to use the same computer during each class session because their files will only be on that computer. Unless your school uses a server, students will also need to use the same computer each time if they are using software that tracks their progress. With this type of software, each student does not need his or her own user account on the computer; the student logs in using a name and password that you have entered for that application on that computer. (See "Installing Software" later in this guide.) By giving each computer a unique name or number and assigning students to specific computers, you will make it easy for students to locate their work each class session.

You set up accounts from the Accounts pane of System Preferences. (Open System Preferences, then click Accounts. Click the plus sign to add a new user account.) To learn more, choose Help > System Preferences Help when System Preferences is open or go to the Mac OS X Support site at http://www.apple.com/support.

The following sections describe different ways you might want to set up the student user accounts:

**One Student Group Account**

You can set up each computer that will be shared by multiple students with two user accounts, one administrator account (for you and other staff) and one student group account. Students using the computers log into the student account with a common user name and password, with the same user name and password used on each computer. When you want to use the computer, you log in as the administrator.

Students who are storing their work on the computers would save their work in different folders on the computer; for example, written work can be saved in the Documents folder. Within the Documents folder, you could set up folders for each class and each student so students could more easily locate their work the next time they log in. You could organize folders in the same way within the Movies, Pictures, and Music folders. All of the students using the group account would share one iPhoto library and one iTunes library, so students could organize their images into albums and their music and other audio into playlists to keep them separate. When students use software that tracks their progress, records are kept for students either on a school server or on the computer used by each student.
User Account for Each Class
Instead of just having one student user account for each computer, you could set up one non-administrator user account for each class that uses the lab. If students save their work on the computers, this setup would make it faster for students to locate their work than having one group account since the account would only include documents created by one class. Each student in that class would log into the class account, where they would store their work.

User Account for Each Student
Another way to configure user accounts is to create a user account for each student who will be using the computer. The student would then use the computer with his or her user account during each class session. Although this takes longer to set up initially, it’s a good way to provide privacy for student work saved on the computer. You may also want individual accounts when students need special settings to accommodate learning or other disabilities.

User Account for Special Projects
You can also consider setting up a user account on a temporary basis for a special long-term project, such as a documentary film. This setup would allow students in a class to easily keep track of their work on that project. At the end of the project, when you no longer need the files or stored settings, simply log in to your administrator account, open the Accounts pane in System Preferences, and delete this user account.

Installing Software
The computers on the lab come with many software applications already installed, such as iMovie, iPhoto, and Safari. (For more information, see “Using the Tools That Come with Your Apple MacBook Learning Lab” later in this guide.) You may want to install other software on the student computers. How software is installed on the computers differs depending on whether your school has a server as well as on the type of software.

If your school uses a server, all of the software that is licensed by the district is installed on the server, usually by the technology staff. The technology staff then installs the necessary application files on the student computers from the server, using server administration software for the process. With some types of software, such as some math and reading titles, each student has his or her own customized settings and the application keeps track of the student’s progress. If a server is used, the student records are stored on the server so that the teacher can access the student reports from any computer on the school network. The application files are installed on the server, with a smaller “client” version of the software being installed on each computer. This type of installation means that students can log in and use the application from any of the lab’s computers since the records are not kept on an individual computer.
If you are responsible for installing software and your school does not use a server, you should first determine how the application needs to be installed. In many cases, the software comes on a CD or DVD that includes installer software or other files that need to be copied to the computer’s hard disk. In other cases, the software is downloaded from the Internet and a serial number is entered. With still other software, the user logs into a subscription website, enters a user name and password, and uses the software via the Internet; with this type of software, no installation is necessary. In any case, make sure to read the installation instructions that come with each software title. Before you install software, you can plug in the computers and set the Energy Saver preferences in System Preferences to Never Sleep so that the computers don’t go into sleep mode in the middle of an installation.

Using Apple Remote Desktop to Install Software

Apple Remote Desktop, software included with the Apple MacBook Learning Lab, provides a quick and easy way to install software that is provided in the installer package format. (The application installer file icon will have the extension .pkg or .mpkg.) Note that you first need to install Apple Remote Desktop on the computer that you will use to install the software.

With this installation method, you log in as the administrator on the computer on which you have installed Apple Remote Desktop. You choose the computers on which you want to install the software, after making sure all of the computers are up and running. (If computers are on the wireless network, it’s best to install software on up to five computers at a time. If computers are connected to the network with Ethernet cables, you can install software on all of the MacBook lab’s computers simultaneously.) Apple Remote Desktop copies the package to the computers you choose and runs the installer with no visible window or user interaction required, and then deletes the installer files when installation is complete. You can even install multiple packages in succession. When you install multiple packages, Apple Remote Desktop copies a package, installs it, and then copies and installs the next package until finished. This means that you can have all the computers up and running and install new software to each of them simultaneously.

You can still save some time with applications that have installers that aren’t in the package format by using Apple Remote Desktop to copy the application’s installer files to the computers. You can then launch the installer and complete the installation on the individual computers. Some software titles don’t have installer files at all; you simply copy a folder to the hard disk. With this type of software, you can use Apple Remote Desktop to copy the files to the computers. After installing software with Apple Remote Desktop, you may need to visit each individual computer to enter a required serial number or activation code.

For more information, see “Apple Remote Desktop: Managing Student Computers from One Computer” later in this guide.
Installing Software on Each Computer

If you’re not using Apple Remote Desktop, or if the software has an installer file that is not in the package format, you’ll need to log into each computer as an administrator and run the installer software. Parents, other adult volunteers, or older students can also help with installing software on individual computers. You can copy the files onto CDs or external hard disks for volunteers to use for installation. Some software titles may need to be installed from a website. In this case, you would connect with the website and download an installer, and then follow the onscreen instructions to finish installation.

With applications that track student progress, you enter settings for each student (such as the level of difficulty) and then the application keeps track of and reports student progress. With this type of software, you would install the application files on each computer and then enter login information and settings for all of the students who will be using the software on that computer. Each student’s progress will then be tracked on that computer. Refer to the documentation that came with the application for installation information such as login names and passwords that you’ll need to enter to set up the software.

Using Internet Subscription Software

With subscription titles that are accessed over the Internet, you’ll often need to enter information to create student accounts, such as a code, a user name, or a password. Using your computer and a projector, you can demonstrate to the class how to log in and use the website before they visit the site for the first time.

Sharing and Storing Files

You can use many different methods for students to store their work and to share files with each other and with you. One easy way to store and share files is if your school uses a server; the student copies the files to a shared folder on the server where others can access them. If your school does not use a server, students can share files using iChat, Apple’s instant messaging software included on every computer. In this case, the student would send files via the iChat message window to others who are connected to the network. (For more information, see “Using iChat to Communicate and Collaborate” later in this guide.) The other user then receives the file on his or her computer. Students can also store files on a USB drive, external hard drive, or an iPod, and then share them by connecting the device to another computer. They can also store and share files by copying them to CDs (or DVDs if the computers have a SuperDrive).

You and your students can also share files with each other by using the file sharing features built into Mac OS X. Students can copy files to other computers on your wireless network and receive those files by using the Drop Box, a folder in the Public folder in each user’s home. The Drop Box allows a student to copy a file to another computer while preventing the student from seeing or accessing any other files on that computer. File sharing is enabled via the Sharing pane in System Preferences. Students can access the Drop Box folders of other computers by choosing Go > Connect to Server in the Finder. To learn how to use file sharing with Mac OS X, use Help when you’re in the Finder or System Preferences, or go to http://www.apple.com/support/leopard to visit Mac OS X Support.
Some schools have a server that students can use to access files from home. Other options are available if no server access is available. If students have files they want to continue working on at home, with an Internet connection and email address at home (and email access at school), they can send an email to themselves with the file and then download the file at home. This works well with small files.

For larger files, having a MobileMe account would be helpful. A MobileMe account, available from Apple on a yearly subscription basis, provides a suite of Internet tools. If you have a MobileMe account for students to use, they can use the account’s iDisk to store files on Apple’s servers and access them online from any Internet-connected computer, whether Mac or Windows. These can be large files that are too big to send via email. Students would place files in the iDisk’s Public folder for easy access from home. Students can also use a MobileMe account and iWeb software to publish their own web pages with movies, podcasts, photos, text, and more. For more information or to sign up for an account, go to http://www.apple.com/mobileme.

Apple Remote Desktop: Managing Student Computers from One Computer

One powerful tool that can help you manage the computers is Apple Remote Desktop, software that is included with the Apple MacBook Learning Lab. Using this software, you can manage all of the computers in the lab from one computer—you can distribute files, configure settings, collect information to create detailed hardware and software reports, and provide remote assistance. For example, you can use the software from your computer to shut down all of the computers for holiday break or to copy homework assignment files to each computer.

You can send text messages to students, such as to remind them it’s time to save their work, and you can observe and control their screens as well (up to 50 screens at the same time), providing an extra tool for classroom demonstration and security. If a student has a question about how to do something, you can use Apple Remote Desktop to actually take control of the student’s computer from your own computer to demonstrate the task. You see the student’s screen on your desktop and so you are able to go through the actions from your computer. You can carry on real-time text chats with the students. In addition, you can use Apple Remote Desktop to display your screen on student computers, an especially useful feature if you don’t have a projector or a large screen display in the classroom. With Apple Remote Desktop, you can also freeze the student screens with the “lock all screens” feature when you need them to focus on another task.

Apple Remote Desktop 3 provides a Dashboard widget that gives you an instant, at-a-glance view of the remote computers in your network. It's fully integrated with the Apple Remote Desktop administrative application, so clicking a particular computer allows you to select and start working with any computer on your network.

Another feature in Apple Remote Desktop 3 is the ability to automate repetitive tasks through the Automator application available on every Mac. Apple Remote Desktop 3 includes 30 Automator actions—you can use them individually or combine them to streamline your frequent tasks.
You install and use the Apple Remote Desktop software from your computer; the “client” software that is used by the students has already been installed on the student computers. For more information, visit the following websites:

  Information about Apple Remote Desktop
  Articles, discussion boards, and other resources

### Using Parental Controls to Provide Extra Security

If you are working with technology staff, they will most likely set up the security on the computers before students use them. If this is your responsibility, you can readily define the privileges for each student account in the Parental Controls pane of Mac OS X System Preferences. For example, the Simple Finder choice (available in the Parental Controls System pane) simplifies the view of the desktop for students when they use the computer. In the System pane of Parental Controls, you are able to define the applications a user can access as well as control the user’s ability to modify the Dock, burn CDs or DVDs, and choose printers. The settings can be different for each user account on each computer.

There are many ways you can use these controls, depending on how students are using the computers in the classroom. For example, you can create an account for video production that provides students access to only those applications they would need for creating movies. Or, if each student has an individual user account, you could create a login account that does not allow Internet access for students who don’t have an Acceptable Use Policy on file that allows them to use the Internet.

In addition to defining applications students can use and settings they can change, you can also use Parental Controls settings to define the Internet sites students can visit, email addresses they can receive mail from, iChat users with whom they can communicate, how long they can use the computer, and more. Later, you can always go back and adjust privileges within an account as well as create new accounts. You can also use a setting in the Content pane to hide profanity in the Dictionary and use the Logs pane to view what websites a student has visited, applications they’ve used, and people they’ve chatted with. Teachers can access Parental Controls from any Mac on a network.

For more information about setting up these controls, open Help when System Preferences is open or when you’re in the Finder.

If your school uses a server, you can use server-based settings to manage security on student computers. To do this, you use Mac OS X Server to define settings and preferences for all the computers and users. The key advantage of using these managed client settings is that every computer can be configured to follow the same settings without having to make the changes on each individual computer. For more details on this capability, visit the following website:

Maintaining Your Apple MacBook Learning Lab

Caring for the Batteries

Your Apple MacBook Learning Lab is designed to make it easy to always have the batteries charged and the computers ready to use. When you store the cart at the end of the day, make sure all the computers are properly plugged in and that the cart itself is plugged into an electrical outlet. The automatic timer included with the lab charges one shelf of computers at a time, and automatically switches between them. It is preset to switch from one shelf to another every two hours, but this can be changed to a shorter period if, for example, you are charging the lab during the lunch break. (See the documentation that came with the cart to learn how to change the timer settings.) This timed rotation system means that the computers will be ready for use in the morning.

When charging a battery, colored lights on the plug of the power adapter show the charging status. An amber-colored ring means that the battery is charging, and a green-colored ring means that the battery is fully charged. You can easily check a computer's battery power status by checking out the battery status icon at the top right of the computer's screen. The icon shows how much battery power the computer has left. You can also see how much battery power a MacBook has left even when it’s shut down by pressing the gray button on the back of the computer. Battery indicator lights display how much battery power remains; the more lights that are lit, the more battery power remaining.

A MacBook can usually last an entire school day without a charge. To be safe, however, you can keep the computers stored in the cart and plugged in when they’re not being used. If a computer's battery does run low during the day, you can simply use a power adapter from the cart to plug in that computer. The following tips will also help to keep the batteries from running low during the school day:

• Turn off AirPort and Bluetooth when they’re not being used.
• Disconnect peripherals that are not in use.
• Quit applications that are not in use.
• Eject CDs and DVDs that are not in use.

Following a few other simple steps will help to maximize the life of the computers’ batteries. At least once a month, it’s a good idea to let the batteries fully discharge and then charge them again. You can do this on a day when you know the lab won’t be used. You just let the batteries run down the day before, refrain from plugging in the lab overnight, and fully recharge them the next day.

At the beginning of the summer break, it’s best to remove the batteries from the computers with a 50% charge and store them in a cool, dry place. When you return for the new school year, put them back into the computers and let them fully charge before turning on the computers. (To remove a MacBook battery, first shut down the computer. Turn the computer over and locate the battery latch. Use a coin to turn the latch 1/4 turn clockwise to unlock the battery. Then gently remove the battery.) When replacing the MacBook battery, place the right side of the battery into the battery compartment at an angle, then gently press the left side of the battery down until it locks into place.
Over a one- or two-week break, no special storing procedures are needed. You can either fully charge the lab before disconnecting it from the electrical outlet or leave it plugged in over the break.

For more information about battery care, go to the following link: http://www.apple.com/batteries/notebooks.html

**Maintenance Routines**

By following a few maintenance routines every two or three months, you can help keep the computers in good shape and improve the student users’ experience. You can do these steps yourself, or have others, such as parent volunteers, help out.

**Updating the software.** Regularly updating the software on the computers will allow you and students to take advantage of new features and other software improvements. To update the Apple software, you can use Software Update, available from the Apple menu or from System Preferences. Just select and install the items you want to update. For third-party software, you might want to check the product websites every so often to see if there are updates that you can download.

**Removing unneeded files.** To free up hard disk storage space on the computers and prevent needless clutter on the desktop, you can regularly move or delete unneeded files. For example, if students have just finished a large iMovie project that has been stored on CDs or DVDs, you can free up hard disk space by removing media files, such as music and video clips. If you want to keep the files that you’re removing, you can store them on a server, if one is used in your school, or you can copy those files on a CD or other media.

**Removing user accounts.** At the end of the year, you can remove individual student user accounts to free up hard disk space on the computers. If you no longer need the files and the settings in a particular user account on a computer, log into the administrator account and open the Accounts pane of System Preferences to delete the user. When you delete the user, all files and home folder settings are deleted.

**Changing the combination.** Changing the combination for the cart's lock every so often will maximize security for the cart. See the documentation that came with the cart for more information.

**Cleaning the computers.** It’s easy to keep the computers clean so students won’t have to deal with sticky keys or fuzzy displays. This is a task that student assistants can help with. Before cleaning a computer, disconnect it from its power source, remove its battery, and make sure it is cool. (See “Caring for the Batteries” earlier in this guide.) You can use purchased laptop cleaning supplies or use a damp, soft, clean, lint-free cloth to clean the outside, keyboard, and trackpad and to wipe the screen. Avoid getting moisture directly in any of the openings. Use only water to dampen the cloth, not any other substances, and don’t spray water directly on the display. After cleaning, you can also replace any computer labeling stickers that are showing wear so that the computers are always easy to identify. When you’re done, replace the batteries and then put the computers back in the cart and reconnect them to the power sources.

For more information, see the documentation that came with your computer or go to the Apple Support site at http://www.apple.com/support.
Tips for Student Use
To help students know how to best care for the computers, you can share the following tips:

• Close the computer’s lid completely before moving it, and make sure there’s nothing on the keyboard, like a pencil, before closing it.
• Don’t stack books or other heavy objects on top of a computer.
• Use the onscreen pointer to point to elements on the screen instead of a sharp object, such as a pen or fingernail.
• Don’t insert anything, especially metal items, into any of the openings of the computer. You could get a shock or break something inside.
• Don’t eat or drink around the computer. Also, make sure your hands are clean before you use the keyboard.
• Keep the computer away from really hot or cold temperatures, as well as rain, snow, dirt, or sand.
• Always carry the computer with two hands, and don’t try to carry anything else at the same time. Carrying the computer close to your chest with your hands folded over it will keep the computer secure if someone accidentally bumps into you.
Using the Tools That Come with Your Apple MacBook Learning Lab

The computers in the Apple MacBook Learning Lab come preinstalled with many useful and exciting applications and technologies, such as digital authoring software, a calculator, and a built-in screen reader. This section describes many of these tools and provides ideas for how you can use them in your classroom.

Using iChat to Communicate and Collaborate

iChat is a perfect tool for student project collaboration, in the classroom or across the globe. This software, which is included with Mac OS X, allows students to connect with others via video conferences, audio conferences, and instant text messages.

Video conferences provide a great way for an expert to “visit” the classroom or for students to take a virtual field trip to another locale. In an iChat video conference, video cameras allow people to see and hear each other at the same time. And with iChat Theatre, students or guests can share presentations, movie projects, or other files during their video chats.

An iChat video conference is easy to set up—all each participant needs is a broadband Internet connection and a Mac that has a built-in iSight camera (included with each MacBook) or that is connected to a webcam or digital video camera.

An audio conference can be one student talking with one other student, or one conversation with up to ten students in ten different locations. No extra equipment is required—you can use the computer’s internal microphone and speakers. Both video and audio chats can be recorded and shared later on the computer or on an iPod.

Students can also chat with others by sending text in real time, an excellent way for students to work together on a project. And while students are chatting, they can also send documents and other files back and forth.

The iChat screen sharing feature lets educators and students, with proper authorization, remotely observe and control the display of another computer in the same classroom or in distant locales. This provides a convenient way for teachers to assist students with technology and for groups to work together.
The security features in the Parental Controls pane in System Preferences let you identify specific people students are allowed to chat with. (For students to be able to chat with others who aren’t on the same local network, such as students at another school, the class will need a MobileMe account name, an AIM screen name, or a Jabber screen name.) Additional security features are included with iChat Server, which is available as part of Mac OS X Server. A school can use iChat Server to set up and run its own private, secure IM server so that students can only chat with others on the same network.

Getting Started

Open iChat, by clicking its icon in the Dock or by double-clicking its icon in the Applications folder.

For more information, in iChat, choose Help > iChat Help to see onscreen help information.

To learn more about iChat, you can visit the following website:
Having Instant Access to Information with Widgets

Dashboard, included with Mac OS X, gives students fast access from the Mac desktop to mini-applications called widgets, which are used to locate information on the Internet and perform common tasks. With widgets, students can quickly check the meaning of a word or find a synonym, translate a word to or from a dozen different languages, convert a unit of measurement, use a calculator, and even check the weather around the world.

When students press the Dashboard key or click the Dashboard icon in the Dock, a semi-transparent layer of widgets appears over the Mac desktop. They then click the widget they want to use.

Mac OS X comes with a variety of widgets. You can download many more or you and your students can create your own. With the Web Clip feature, you just clip out part of a Safari web page to make it a widget—when the page updates, so does the widget.

With widgets, your students can instantly find information they need for a project, without having to open a web browser or other application or look for other resources.

Getting Started

Click the Dashboard icon in the Dock or press the Dashboard key (F4 on the current MacBook, F12 on older models). Click the plus sign that appears to the left of the Dock to see the other widgets installed on the computer.

To have an installed widget appear on the desktop whenever you open Dashboard, drag the widget from Dashboard to the desktop. To add more widgets, when Dashboard is open, click the Open button (+) to open the widget bar, click Manage Widgets, then click More Widgets. When you're done using the widgets, press the Dashboard key again or click outside the widgets to hide the layer.

You can also download additional widgets by visiting the following website: http://www.apple.com/downloads/dashboard

To learn more about Dashboard and widgets, you can visit the following website: http://www.apple.com/macosx/features/dashboard
Finding Files in a Flash with Spotlight

Spotlight, included with Mac OS X, allows students to quickly find anything on their computer or on shared computers on their network from one search field. Students can access Spotlight from the icon at the right of the menu bar or by choosing File > Find in the Finder.

Spotlight looks at all types of items, including images, folders, music files, calendars, applications, documents, and more. Spotlight doesn't just search for the titles of those items but actually looks at the contents of files or documents—the text in a report or an event in a calendar, for example.

Spotlight helps students stay organized in their class work. They can find files even if they don't know the exact date, but just have an idea of when they created a file, such as, “This Week” or “This Month.”

The results of the search are displayed in a list that can be organized in different ways. Students can quickly browse through the results and see a preview of the first page of each file with the Cover Flow view. Once they find the file they want, they can open it directly from the results list.

Search results can be saved in a “Smart Folder,” which Spotlight then updates as files matching those criteria are added or deleted. For example, students who are writing an American history paper might have a Smart Folder for a search they have done on “Jefferson.” As they add more images or information about the topic, Spotlight automatically adds those items to the Smart Folder.

By using the Spotlight preferences in System Preferences, you can prevent students from being able to search particular locations on their computers. You can also change which categories are displayed in the results list and the order in which they appear.

Getting Started

Click the Spotlight icon at the right of the menu bar at any time or, when you’re in the Finder, choose File > Find.

To learn more about Spotlight, you can visit the following website:
http://www.apple.com/macosx/features/spotlight
Crunching Numbers with Calculator and Grapher

Mac OS X includes two invaluable tools for math students: Calculator for performing calculations and Grapher for graphing equations.

Calculator offers three different types of calculator faces in one application. The basic calculator handles basic mathematical operations that involve addition, subtraction, multiplication, and division. The scientific calculator works with advanced computations, including trigonometric and logarithmic functions. The programmer’s calculator performs logical operations (such as AND, OR, XOR, and NOR) and handles calculations in hexadecimal, octal, or decimal systems. Calculator is also a handy tool for doing conversions, such as from miles to kilometers, or ounces to grams.

Students can easily check and edit their basic and scientific calculations—they can display their calculations in a “paper tape” list as they enter them and then print or save the list.

Calculator is also designed to be accessible to all students. By choosing commands from the Speech menu, students can hear the value or function of each button they press as well as the result of each calculation.

With Grapher, students can create many different types of two- and three-dimensional graphs and then analyze the results. They can create an equation by entering it from scratch or speed the process by choosing a template and making selections from an equation palette. The application can display graphs for a variety of equations, including parametric curves and surfaces, differential equations, and discrete series. Students can see examples of each type of graph before creating their own graphs.

Completed graphs can be exported as images or as PDF files. Students can also create an animation from any equation that uses a parameter they’ve defined and then save that animation as a QuickTime movie.

Getting Started

Open Calculator by clicking its icon in the Dock or by double-clicking its icon in the Applications folder. For more information, in Calculator, choose Help > Calculator Help.

Open Grapher by double-clicking its icon in the Utilities folder in the Applications folder. For more information, in Grapher, choose Help > Grapher Help.
Browsing the Internet with Safari

Students can quickly locate information and visit websites with Safari, the fast and easy-to-use web browser included with Mac OS X. Students can search the web with the built-in Google Search field at the top right of the Safari window and bookmark sites for easy access later.

As students conduct research, they often find sites that they want to return to later. It's easy to add a bookmark that can be displayed either on the navigation bar or on the Bookmarks menu so students won't waste time searching for that page again. Safari also includes enhanced features such as tabbed browsing, which lets students open multiple web pages and switch between them in a single window. If students are using web pages that might not be available for long, they can use the Safari archive feature to save pages and their contents.

Safari is also an excellent tool for providing students with current events. Many news organizations, community websites, and personal weblogs offer headline and article summaries in the form of news feeds using the RSS (Really Simple Syndication) technology. This content is presented in the Safari window as a simple, ad-free list. This means students can quickly find all of the news articles that might interest them from across the web gathered together in one place.

With the security features included with Parental Controls in System Preferences, you have the option to limit the sites students visit on the web. This is a great feature for younger students as well as when you want students to focus on a select group of websites. You can also set up Safari preferences to block pop-up windows from appearing on student computers.

With Safari, websites are readily accessible to students with visual impairments or learning differences. Students can have selected text in a web page read to them out loud by using choosing Safari > Services > Speech as well as by using VoiceOver, the Mac OS X built-in screen reader.

Getting Started

Click the Safari icon (the compass) on the Dock or double-click the icon in the Applications folder.

Choose Help > Safari Help to see onscreen help information.

To learn more about Safari, you can visit the following website:
http://www.apple.com/macosx/features/safari
Staying Up to Date with iCal

Students will always know when their projects are due with iCal, software for creating and managing calendars. iCal is included with Mac OS X. Calendars created with iCal can be printed or shared in a number of other ways. If students have their own user accounts on the computers, they can create and maintain their own calendars, or you can distribute a class calendar file for them to update as needed. With a MobileMe account, you can publish a class calendar on the Internet that students and their families can view at home if they have an Internet connection.

You and your students can use calendars in iCal to record and view dates for homework, tests, holidays, field trips, and other school activities, and more. When you enter an event in a calendar, you can also add notes about the event; this helps students stay on top of the details of an assignment.

Different calendars can be created for different purposes (for example, one for a long-term class project, another for homework), with each calendar assigned a different color. All calendars can then be displayed in one window. It’s easy to switch between viewing a calendar by day, week, or month as well as to update the calendar with new information or dates.

Students can keep track of things they need to do by creating To Do lists in iCal, setting priorities and due dates for each item. Any event or To Do item that has a due date can have an “alarm” set up, so students receive either a message or hear a sound at a specified date and time before the due date.

When iCal is used with a compatible CalDAV server like Mac OS X Server’s iCal Server, it can be used within a school to set up meetings, book conference rooms, or schedule the use of equipment, such as mobile labs or projectors.

Getting Started

Double-click the iCal icon in the Applications folder.

Choose Help > iCal Help to see onscreen help information.

To learn more about iCal, you can visit the following website:
http://www.apple.com/macosx/features/ical
Producing Digital Media Projects with iLife

Each computer in your Apple MacBook Learning Lab includes the iLife suite of applications, providing all the tools students need to create and share compelling digital media projects—an engaging way to express their knowledge in any subject area. The iLife applications are:

- iPhoto for importing, organizing, editing, and sharing photos
- iMovie for combining video, sound, and pictures in digital movies
- GarageBand for creating and recording music and podcasts and for learning how to play instruments
- iWeb for creating web pages that can include photos, movies, blogs, and podcasts
- iDVD for producing DVDs to store and share digital media projects (requires that computers have a SuperDrive)

All of these applications are simple to use and are designed to work with each other. This means, for example, that students can readily use a podcast created in GarageBand on a web page created in iWeb, or import pictures from iPhoto into an iMovie documentary.

Creating digital media projects with iLife provides a great opportunity for students to work in groups, with roles divided based on interests or skills. One group can be using the MacBook lab’s computers to write a storyboard and script for a movie, for example, while other groups locate images and compose a soundtrack.

iLife projects can support student learning in all curriculum areas. For example, students can use iMovie to produce a public service announcement or a story in a foreign language and then use iDVD to produce a DVD to share. Students can use GarageBand to produce a class podcast, record a radio show from another era, or create the background music for a historical documentary. iPhoto can be used to produce a book of student math problems, a slideshow of a field trip, or an illustrated class calendar. And you can use web pages created with iWeb to present student projects, such as daily reading blogs or reports of science experiments.

Once students have completed digital media projects with iLife, they will find it exciting to share them with others. One easy way to present student projects to the whole class is by using Front Row, software included on MacBook computers. Front Row lets you navigate the content on the computer with simple menus, making it easy to find and present student work.

To learn more about iLife, you can visit the following website:
http://www.apple.com/ilife

To access iLife tutorials, visit http://www.apple.com/ilife/tutorials.
Creating Digital Stories with iMovie

Making movies offers students the opportunity to develop many skills—planning, research, writing, project management, collaboration, and communicating visually as well as with text and audio. iMovie allows students to easily produce engaging, high-quality movies.

Students can start with a storyboard and script of their movie project. Their movies can include video they capture with a digital camcorder or that they save from the Internet or other sources. Movies can also include digital photos and scanned artwork from an iPhoto library.

iMovie organizes a student’s video clips into one library, organized by Events, which are based on the day the video was shot. This organization, as well as the ability to quickly play or “skim” a clip, makes it easy for students to find just the footage they want to use. Students add clips they want by dragging them into the project area and then edit their clips using the tools provided in the Precision Editor. They can also add photos, narration, a musical soundtrack, titles, effects, and transitions to their movie projects.

Students can enhance their movie projects by using the new map feature in iMovie to add animated maps of relevant locations. And at any point in the process, they can apply a dynamic theme, such as Bulletin Board or Comic Book, with which animated titles and transitions are automatically added.

The final product can be burned on a CD, viewed in class with a projector connected to one of the computers, or posted to a class website. If the notebook computer has a SuperDrive, the finished movie can be imported into iDVD, another iLife application, to produce a DVD. The DVDs can then be viewed on a television with most DVD players or viewed on the computers with the DVD Player application, also included with Mac OS X.

With the MacBook lab’s computers, students can readily share files and be working on different aspects of the movie at the same time, such as recording narration, performing research on the Internet, writing a script, and so on.

Getting Started

Click the iMovie icon in the Dock or double-click the icon in the Applications folder.

For more information, in iMovie, choose Help > iMovie Help.

To learn more about iMovie, you can visit the following website: http://www.apple.com/ilife/imovie
Creating Digital Music and Podcasts with GarageBand

GarageBand lets students create music and podcasts and learn how to play an instrument. To create music, students can get started with the Magic GarageBand feature, with which a student assembles a virtual band and takes center stage with his or her choice of instrument.

Students who have no musical training can compose pieces right away by using the program’s loops, which are prerecorded music segments played in different moods and genres on a variety of instruments. Thousands more loops can be added with the purchase of the GarageBand Jam Pack collections. Or, students can plug in a guitar, keyboard, or microphone and record their own music and then use loops to add more tracks. GarageBand can record up to eight audio tracks at once and record multiple takes. By using the built-in GarageBand keyboard or a USB or MIDI keyboard, students can play and record more than 50 software instruments included with the application.

While recording, GarageBand displays full musical notation that can be printed. After recording, students can make changes to their compositions, such as adding effects and changing the pitch or tempo.

All GarageBand projects can be exported to iTunes and then can be used for the soundtrack of an iMovie project or iPhoto slideshow, downloaded directly to an iPod, and more. You can also use GarageBand to record different types of student assessments—to capture samples of reading skills and foreign language mastery, for example—and then export and save the files in iTunes.

GarageBand also now includes a series of interactive lessons for learning piano and guitar. In addition, Artist Lessons from songs’ original artists can be purchased from within GarageBand.

GarageBand also makes it easy to create professional-quality podcasts, all in one application. Students can record the audio in GarageBand by plugging in a microphone or using the computer’s built-in microphone. Students can then add images from iPhoto for a podcast artwork track and select from a collection of special effect sounds and jingles or add music to enliven their audio. They can also create movie podcasts. GarageBand will adjust the sound quality and volume levels, then students can publish their podcast directly to iTunes or to a web page using iWeb and a MobileMe account.

Getting Started

Click the GarageBand icon (the guitar) in the Dock or double-click the icon in the Applications folder.

For more information, in GarageBand, choose Help > GarageBand Help.

To learn more about GarageBand, you can visit the following website: http://www.apple.com/ilife/garageband
Organizing, Editing, and Sharing Digital Photos with iPhoto

iPhoto, included on each new computer as part of the iLife suite of applications, is a comprehensive but easy-to-use tool that allows you and your students to import, organize, edit, and share digital images.

Connect a digital camera to the MacBook and iPhoto automatically opens, ready to import photos. iPhoto automatically organizes photos in its library into Events, which are based on when the photos were taken. Photos can also be placed into albums, which may include photos from different Events. With the new Faces feature, you can organize photos by the specific people in them, and the new Places feature lets you categorize photos by where they were taken.

Students can edit all of the images in their iPhoto library—for example, they might want to crop unwanted portions of a photo, eliminate red-eye, adjust contrast, or rotate a photo.

Images in an iPhoto library can be used to produce books, cards, calendars, and slideshows with a choice of themes and music and narration. Books created with iPhoto can include text as well as images and then can be printed, saved as a PDF, produced as a book ordered from Apple, converted to a slideshow, and more. Images from an iPhoto library can be used in other applications, such as in iMovie projects and word-processing documents.

iPhoto offers many ways to share classroom photos with students’ families or others. Photos from iPhoto can be sent to others via email or displayed on web pages (that can be password protected) using iWeb or the MobileMe Web Gallery, where parents and other visitors can view and download the images. You could also display a slideshow at back-to-school night or send home printed copies of iPhoto books to showcase student work.

Each individual user account has its own iPhoto library, which means that students who share a user account with other students will have a shared iPhoto library as well. By turning sharing on in iPhoto preferences, computers on your local network can share the same photos in a library, with those libraries appearing in the Source list at the left of the iPhoto window.

Getting Started

Click the iPhoto icon (the camera with a photo) in the Dock or double-click the icon in the Applications folder.

For more information, choose Help > iPhoto Help.

To learn more about iPhoto, you can visit the following website:
http://www.apple.com/ilife/iphoto
Building Websites and Blogs with iWeb

With iWeb, students are able to readily create professional-looking websites that can include blogs and other text, movies, podcasts, and photos, all without the need to know any HTML programming.

Students start by choosing from a collection of Apple-designed templates and then add the types of pages they want. Students drag the elements they want to include on their pages from the Media Browser—podcasts, photos, movies, and music. They add text by typing to replace placeholder text or by copying and pasting text from another application.

It’s easy to customize the web pages students create. For example, images in iWeb can be adjusted right on the page without any need to return to iPhoto to make those edits.

Blog pages provide an exciting way for students to document the progress of group projects, share reflections on completed projects, or even produce writing projects. With blogs, as with other types of pages within iWeb sites, all the navigation is taken care of, making it simple for users to move from page to page.

iWeb also makes it easy for students to publish their podcasts. They can add their podcast to a web page by dragging it from the Media Browser in iWeb or they can send it directly to iWeb when they’re working in GarageBand or iMovie. Once they’ve established a podcast series in iWeb, they can readily add any new episodes they create. iWeb even allows students to submit podcasts to the iTunes Store so anyone can find them by subject, genre, or title.

Once a website is completed, it can be instantly posted with one click to your school server without the use of an FTP or published on the Internet via a MobileMe account. If you want to limit access to the sites, you can password protect the sites before they are published.

Getting Started

Click the iWeb icon (the bulletin board) in the Dock or double-click the icon in the Applications folder.

For more information, in iWeb, choose Help > iWeb Help.

To learn more about iWeb, you can visit the following website:
http://www.apple.com/ilife/iweb
Organizing and Playing Music and Audio with iTunes

iTunes provides students an easy way to locate, import, organize, store, play, and share music, audiobooks, and other types of audio files, such as historical speeches and podcasts.

Students add music and other audio to their iTunes library by importing tracks from CDs, importing GarageBand files and other audio files saved on the hard disk, or downloading files from the iTunes Store or the Internet. The iTunes U section of the iTunes Store includes a large collection of free academic content that can be added to an iTunes library. iTunes U includes K-12 academic content from State Departments of Education and content from over 130 leading universities and colleges. The Beyond Campus section of iTunes U includes professionally-created content from more than 200 providers such as PBS, NPR, and American Public Media, as well as from museums, such as the Smithsonian, The New York Public Library, the Brooklyn Museum, and many more. Students can also import songs they composed and performed in GarageBand and narration or reading samples they recorded.

Files in iTunes can then be organized into “playlists” so students can have separate groups of audio files for each of their projects. An iTunes library is set up for each user account on a computer, so students who are sharing a user account with other students will have a shared iTunes library as well.

Students can readily use items in their iTunes library in digital media projects created with iLife applications, such as movies created with iMovie or iPhoto slideshows. In addition, students can burn CDs with items from their playlists or use iTunes to listen to audio files. Headphones can be connected to the computer for listening in the classroom. iTunes is also used to sync iPod devices to the contents of an iTunes library and to store recordings made with an iPod and a voice recorder.

Students can easily share their iTunes libraries with others in the classroom when sharing is selected in iTunes preferences. This means that students can listen to audio saved on other computers without needing to download those audio files. (They can't transfer these files to their own iTunes playlists in this way, however.) With sharing selected, computers on your local network automatically seek out other computers on the network and connect to their shared music libraries.

Getting Started

Click the iTunes icon (the musical note on a CD) in the Dock or double-click the application icon in the Applications folder.

For more information, in iTunes, choose Help > iTunes Help.

To learn more about iTunes, you can visit the following website:
http://www.apple.com/itunes/overview

To learn more about iTunes U, visit the following website:
Reaching All Learners with Built-in Accessibility Features

Mac OS X v10.5 Leopard offers a wide collection of accessibility tools and technologies to address the needs of all students. Many of these features, including a built-in screen reader that supports a variety of refreshable Braille displays, are available via settings in the Universal Access pane in System Preferences. With a computer customized for each student’s needs, students with a variety of learning differences can work side by side and collaborate on the same projects with other students.

For example, students with visual impairments can use the VoiceOver screen reader to have the content of web pages and other documents read aloud and to hear a description of activities taking place on their computer, all with an advanced synthesized voice that uses natural intonation. They can use the Zoom option to magnify everything on the screen, Display settings to change the screen to show white text on a black background or change the contrast, and Speech Recognition to use spoken commands to control their computer. With text-to-speech, text—such as a website, a Dictionary entry, or numbers entered in Calculator—can be read aloud.

For deaf or hard-of-hearing students, QuickTime videos can have a text track added to provide captions, and visual alerts can take the place of sound alerts. Additional built-in features, such as Sticky Keys, which allows a user to press keys in a sequence instead of simultaneously, are designed to assist those who have physical difficulties using the mouse or keyboard.

It’s easy to set up these features to assist a student. If each student will have his or her own account on a specified computer, you can select options in the Universal Access pane of System Preferences for each student. You can do this on the computer itself, or from your computer if you are using Apple Remote Desktop, which allows you remote access to each computer on the local network.

Getting Started

Click the System Preferences icon in the Dock or choose Apple menu > System Preferences, then click Universal Access. Click the question mark button to see help information about each set of options.

To learn more about Apple’s accessibility tools, you can visit the following website: http://www.apple.com/accessibility

To download the “Getting Started: Apple Technology for Diverse Learners” PDF document, go to http://www.apple.com/education/teachers-professors/resources.
Communicating via Email with Mail

The Mail program included with Mac OS X can be used to send, receive, and keep track of email messages. With the search features included in Mail, you can locate emails quickly, searching the content of messages or searching for the name of a sender, recipient, or for specific text in the subject of a message.

The Mail application can be set up to be used with more than one email account, such as a school district account as well as a MobileMe account or an account from another provider.

You and your students can organize emails into mailboxes, which are like folders, and can create mailboxes inside of other mailboxes. You can set up Smart Mailboxes based on different criteria so messages that meet those criteria are automatically saved in that mailbox.

Mail supports student writing, with the application able to check spelling as students type. They can also use the To Do lists and Notes included with Mail to stay organized. And the application's professionally designed templates, accessed by clicking Show Stationery in a new message window, make it a snap to produce great-looking emails, such as an invitation to families to come to a class event.

Security is not an issue when students use Mail—for each student login account, you can list specific email addresses that the user is allowed to communicate with, such as those of students collaborating on a project from another school. Email received from people not on the safe list are sent to you to determine if they can be sent on to that student.

Getting Started

Click the Mail icon (the stamp) in the Dock or double-click the application icon in the Applications folder. You can set up a user’s account by choosing Mail > Preferences. For more information, in Mail, choose Help > Mail Help.

If you don’t have an email address that the class can use, purchasing a MobileMe account provides an email account, Internet storage space, and many other services. You can sign up for a MobileMe account at http://www.apple.com/mobileme.

To learn more about Mail, you can visit the following website: http://www.apple.com/macosx/features/mail
Supporting Writing with Dictionary and TextEdit

The computers that come with the Apple MacBook Learning Lab include additional software to support student writing in the classroom:

- The Dictionary application, which includes a full dictionary and thesaurus
- TextEdit, a word-processing application

**Dictionary**

With Mac OS X, students have full access to the *New Oxford American Dictionary*, the *Oxford American Writer’s Thesaurus*, Wikipedia (with an Internet connection), and an Apple Dictionary, all combined in one application. Students just select which resource they want to consult, or choose all of them, then start typing a word in the search field. If a single entry matches the word, the Dictionary goes right to that word. If multiple words match, a list of candidates appears. Definitions are listed in order of common use and include derivatives and origins. Students can hear the words and definitions read aloud.

You can use a setting in Parental Controls in System Preferences to prevent Dictionary from displaying profanity.

To get started with Dictionary, double-click its icon in the Applications folder. Students can also use the Dashboard Dictionary widget to access the dictionary, Thesaurus, and Apple dictionary. For more information, in Dictionary, choose Help > Dictionary Help.

**TextEdit**

TextEdit is a versatile word-processing application that includes many features that are particularly helpful to student writers. TextEdit includes spell check, word completion, and can even speak aloud an entire document or selected text. Students can view, create, and edit documents containing combinations of multilingual text, graphics, movies, and other document files.

To get started with TextEdit, double-click the TextEdit icon in the Applications folder. For more information, in TextEdit, choose Help > TextEdit Help.
More Tools to Use with Your Apple MacBook Learning Lab

You can enhance the use of the Apple MacBook Learning Lab in the classroom with additional tools such as Apple K-12 Curriculum Collections, iPod, or iWork software.

Enhancing Student Learning with K-12 Curriculum Collections

The Apple K-12 Curriculum Collections provide a variety of educator-endorsed software and other tools for learning math, science, language arts, and other core subjects. Each collection offers products that come from leading educational developers, offer an interactive and media-rich learning environment, and help you address individual student needs. You can choose from the following collections:

- Early Learning (Grades K-2)
- Upper Elementary (Grades 3-5)
- Middle and High School Language Arts
- Middle and High School Math and Science

To learn more about the K-12 Curriculum Collections, you can visit the following website:

Using iPod as a Mobile Learning Tool

Purchasing iPod devices to go with an Apple MacBook Learning Lab gives students access to a versatile mobile learning tool. And because the iPod is so portable, it’s also a great way for students to share their work with their families.

Students can use an iPod to listen to speeches, music, and podcasts, which are recorded audio files posted on websites. They can listen to audiobooks while following along with the written text—an aid for younger students or those with reading difficulties. iTunes, an application included on each Mac computer, is used to copy, or “sync,” audio files to an iPod.

Small voice recorders are available that connect to many models of iPod devices. With a voice recorder, students can record interviews, field trip notes, foreign language samples, math facts, and more. The recorded audio files are then easily imported into iTunes and can be used in other applications, such as in an iPhoto slideshow. You can also use an iPod and a voice recorder to record information for students to listen to, such as instructions for a science experiment.

With models of iPod that display photos, students can combine photos with audio to document a field trip, for example. Photos can be added by syncing them from iPhoto. Depending on the model, an iPod can also display video, such as a documentary film students have created with iMovie. Also, the iPod can be connected to a TV or projection unit to display files saved on the iPod, such as a Keynote presentation.

Text can also be displayed with the iPod (except for the iPod shuffle), so students can read as well as hear speeches and other spoken word files as well as see their calendars produced in iCal. Audio files downloaded from the Internet may include visual files, such as text or video. The iPod nano (fourth generation) even includes accessibility features such as optional spoken menus and the choice of a larger font size.

Some iPod models can also be used as a hard disk, helpful for transporting large files, such as digital media files between computers in the classroom or between home and school. (You enable this feature in iTunes preferences when the iPod is connected to the computer.) The iPod also gives you a convenient way to keep up to date with professional development information that you download from iTunes U or the Internet. It’s easy to keep all of the iPod devices in your lab charged by connecting them to a USB hub when they’re not being used. You can also purchase an Apple iPod Learning Lab that makes it easy to store, charge, sync, and share multiple iPod devices within a school.

To learn more about iPod in education, you can visit the following website:

To learn more about the Apple iPod Learning Lab, visit
Creating, Presenting, and Publishing Work with iWork

iWork, which can be purchased for use with the Apple MacBook Learning Labs, includes three applications: Pages, a streamlined word processor, or Keynote, easy-to-use cinema quality presentation software, and Numbers, an innovative spreadsheet. All are valuable tools with many uses for classroom projects.

With Pages, students can create a variety of documents, such as a script, newsletter, web page, or a term paper. They can start with one of the many professionally designed templates that make it simple to produce great looking documents, then add text, images, charts, and other elements.

With Keynote, students start by choosing from a collection of themes, and then create slides with text, charts and tables, images, audio, recorded narration, and other media. They can then add animation effects and transitions. When they’re done, students have many options for sharing and exporting their presentation. They can show their work from the computer, post it on a website, save it on a CD or DVD, or save it as a PDF, QuickTime, Flash, or PowerPoint file.

Numbers provides students with easy-to-use tools for calculating, analyzing, and organizing data. Students start by choosing a template, such as a lab report or a blank spreadsheet, or they can open a table that you have formatted for them. (Each table is a spreadsheet.) They can then readily add data and functions, present a table’s data in a 2D or 3D chart, and add movies, photos, and audio files. Students can easily customize their document in many ways. Numbers offers many printing options, or the finished table can be exported for use by Excel or saved in PDF or CSV format.

With the Media Browser included in iWork, it’s easy to import files from iMovie, iTunes, and iPhoto into Keynote, Pages, and Numbers, such as adding audio files from an iTunes playlist to a Keynote presentation, or using images saved in iPhoto in a Numbers lab report.

These applications are also helpful tools for teachers. You might want to use Keynote to create a presentation to show at a school open house, use Pages to produce a monthly newsletter to send home to students’ families, or use Numbers to keep track of students’ grades with the included grade book template.

To view tutorials and other information for the applications in iWork, you can visit the following website: http://www.apple.com/iwork.
Additional Resources

For resources specific to each application and feature discussed in this booklet, see the “Learn More” information in that section. This section provides an overview of the collection of resources you can use to get more ideas about using your Apple MacBook Learning Lab in the classroom.

Apple Learning Interchange
http://edcommunity.apple.com/ali
Apple Learning Interchange (ALI) showcases best-practice teaching strategies that are rich with technology. The site includes a collection of educator-created lesson plans, digital learning events, and many other online learning opportunities. It also provides a way to locate other educators for collaborating via iChat. These resources are always available via the Internet free of charge, with new content being added all the time. The Apple Learning Interchange provides a dynamic environment for educators to view content, publish, and collaborate.

Apple Websites
You can visit various Apple websites to learn more about using the tools in the Apple MacBook Learning Lab to integrate technology into your classroom.

Resources for Education
Includes guides such as “Getting Started: Apple Technology for Diverse Learners,” lesson plans, and tutorials
http://www.apple.com/education/teachers-professors/resources

K-12 Curriculum Collections
Information about these collections of software and other tools for the classroom

Find Out How in the Classroom
Series of tutorials exploring using the Mac in the classroom

Find Out How—Mac Basics
Video and text tutorials for using the Mac
http://www.apple.com/findouthow/mac
iLife
Tutorials and other information for iLife
http://www.apple.com/ilife

iWork
Tutorials and other information for iWork
http://www.apple.com/iwork

Mac OS X Features
Information about Mac OS X, including Safari, iChat, iCal, Mail, and more
http://www.apple.com/macosx/features

Widget Downloads
Links to additional widgets to download to Dashboard

iTunes
Information about iTunes
http://www.apple.com/itunes/overview

Mobile Learning
Information about mobile learning, including iPod and a guided tour of iTunes U

Apple Professional Development
http://www.apple.com/education/apd
Apple Professional Development offers a wide array of workshops to help educators effectively infuse technology into the classroom. A two-day workshop can be purchased with your lab that will help you learn how to use all the tools that came with the lab as well as give you ideas for effectively integrating the technology into your curriculum. This and all other workshops are by taught experienced professionals who are well versed in the needs of today’s students and educators.

Apple Support
http://www.apple.com/support
The Apple Support website provides a comprehensive collection of tutorials, answers to troubleshooting questions, discussion boards, software updates, product specifications, tips, and more. From the main support page, you can find information specific to the software discussed in this guide.
Apple MacBook Learning Lab Teacher Sign-Up Sheet

Week of: ________________________________

<table>
<thead>
<tr>
<th></th>
<th>Monday</th>
<th>Tuesday</th>
<th>Wednesday</th>
<th>Thursday</th>
<th>Friday</th>
</tr>
</thead>
<tbody>
<tr>
<td>8:30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9:30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10:30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11:30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12:30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1:30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2:30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Apple MacBook Learning Lab Teacher Checkout Sheet

Date ________________________________
Teacher ________________________________
Period ________________________________

<table>
<thead>
<tr>
<th>Computer</th>
<th>Student Name</th>
<th>Time Out</th>
<th>Time In</th>
<th>Comments/Needs Attention</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Computer 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Computer 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Computer 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Computer 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Computer 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Computer 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Computer 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Computer 9</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Computer 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Computer 11</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Computer 12</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Computer 13</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Computer 14</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Computer 15</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Computer 16</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Apple MacBook Learning Lab Teacher Checkout Sheet

<table>
<thead>
<tr>
<th></th>
<th>Monday</th>
<th>Tuesday</th>
<th>Wednesday</th>
<th>Thursday</th>
<th>Friday</th>
</tr>
</thead>
<tbody>
<tr>
<td>Week of:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8:30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9:30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10:30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11:30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12:30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1:30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2:30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

|          |        |         |           |          |        |
| Week of: |        |         |           |          |        |
| 8:30     |        |         |           |          |        |
| 9:00     |        |         |           |          |        |
| 9:30     |        |         |           |          |        |
| 10:00    |        |         |           |          |        |
| 10:30    |        |         |           |          |        |
| 11:00    |        |         |           |          |        |
| 11:30    |        |         |           |          |        |
| 12:00    |        |         |           |          |        |
| 12:30    |        |         |           |          |        |
| 1:00     |        |         |           |          |        |
| 1:30     |        |         |           |          |        |
| 2:00     |        |         |           |          |        |
| 2:30     |        |         |           |          |        |
| 3:00     |        |         |           |          |        |